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Eco 302-01W: Business & Eco Stat [CRN # 81445]  
Syllabus (Fall 2025): 08/25/2025 – 12/12/2025 

Professor: Dr. Kishor Guru-Gharana 
Office: BA 208 
Office Hours: Zoom (link will be emailed) 
Class Hours: Web based class 
Phone: 903.886.5703 (off); Fax: 903.886.5702  
Preferred Form of Communication: email (24/7 during semester) 
Communication Response Time: within 24 hours 
Class Hours: Fully Web based 

Email: kishor.guru-gharana@tamuc.edu 

 

Course Information 

Required Text: No textbook required. Professor will provide all the materials through D2L. 

Software Required: Excel with Analysis ToolPak (Free version) 

To enable the Data Analysis ToolPak in Excel, navigate to File > Options > Add-Ins. Select 
"Excel Add-ins" from the "Manage" dropdown and click "Go". Check the box next to 
"Analysis ToolPak" and click "OK". You can then access the tool under the "Data" tab, in 
the "Analysis" group.  

 

If you're using Excel for Mac, in the file menu go to Tools > Excel Add-ins. 

1. In the Add-Ins box, check the Analysis ToolPak check box, and then click OK. 

 If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to 
locate it. 

 If you are prompted saying “the Analysis ToolPak is not currently installed 
on your computer”, click Yes to install it. 

Catalog Course Description: This course satisfies the background requirements for quantitative 
analysis and techniques. The course will cover descriptive statistics, inferential statistics and 
models with business applications to analyze business problems. Specific topics include: 
measures of central tendency and variation, probability distributions, estimation, hypothesis 
testing, regression and correlation. 

Student Learning Outcomes: 

By completing this course, the student will able to: 

1) Calculate and apply measures of location and measures of dispersion. 
2) Apply discrete and continuous probability distributions to various business problems. 

mailto:kishor.guru-gharana@tamuc.edu
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3) Understand the meaning of null and alternative hypotheses, type I and type II errors and to 
perform test of hypothesis including Z and t-tests. 
4) Calculate confidence interval for a population parameter for mean and proportions. 
5) Compute and interpret the results of Bivariate Regression and Correlation Analysis. 
6) Interpret regression results generated by a computer software. 

 

Course Requirements 

Minimal Technical skills Needed 

High school algebra; using Excel spreadsheet, Excel functions and Excel graphics; and using 
PowerPoint. 

Instructional Methods: The professor will provide lecture/notes through D2L Brightspace 
Content. Moreover, the Professor will provide power point slides with solved examples and 
explanations in D2L Brightspace. Questions can be asked through email. 

Student Responsibilities/Tips for Success in the Course 

1. Students are expected to:  
a. Read text assignments as scheduled.  
b. Read the Lectures/notes provided by the Professor. 
c. Work the assigned homework problems independently.  Submit the homework problems 
due as indicated in the appropriate drop box of D2L Brightspace.  
d. Read the regular announcements in the Announcement section of the D2L Brightspace and 
download the posted materials with download links. 

2. This syllabus is tentative for the semester.  It is meant to be a guide.  Certain topics may be 
stressed more or less depending on class progress, and certain topics may be omitted. 

3. Homework problems are assigned and graded every 7 weeks. Solution to Assignment 
problems will be provided after the deadline for submission. 

5. I provide detailed Instructions with examples for each Topic. 

6. You must show your work in Essay type (or Written response) questions to receive full points. 
You only need to mark the correct answer in T/F and MC questions. 

7. Feel free to ask questions through email or other online tools. I am accessible 24/7 through 
these channels even during weekends or holidays. You can ask any question related to the course 
topics and I try to answer them within few hours (usually within 24 hours).  

8. Demeanor: “All students enrolled at the university shall follow tenets of common decency and 
acceptable behavior conducive to a positive learning environment”. See Students Guide Book. 

9.  Attendance Policy:  This is fully Web based class. 
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Grading 

 
Grade Component                                     Points  
Four Assignments (4*100)                           400 
Final Exam (Topics 4-10)                         600 
Final grade in the course is the average from the student’s total score from the sum of 
(Assignments + Final) above. 
Average Range                Grade 

90%-100%                            A  
80%-89%                              B  
70%-79%                              C 
60%-69%                              D 
Below 60%                           F 

 

EXAMS SCHEDULE  

Exams  Window Period starts* Window Period ends** Topics Covered  

Final Exam 
(Seven hrs.) 

Morning of Monday, 
Dec 8th, 2025 

Midnight of 
Wednesday, Dec 10th, 
2025 

4-10 

 

*Uploading will be done in the morning (8 a.m.) of the starting date. The Final has a five-days’ 
window period with time limit once you start the tests. It has a Seven-hour time limit. The Exam 
is a one-take Exam. That is, you must finish the Exam in a single take. 

**Mid-night (11:59 p.m.) of the Last Date. Start at least 7 hours earlier than 11:59 p.m. of the 
last date for the Final. Once the time passes 11:59 p.m. of the last date or you have spent the 
given time limit for the test (whichever comes first), the system will kick you out of the test. So, 
be very careful about the time remaining while taking the test. 

MyLeo Support 

Your myLeo email address is required to send and receive all student correspondence. Please 
email helpdesk@tamuc.edu or call us at 903-468-6000 with any questions about setting up your 
myLeo email account. You may also access information at myLeo.  https://leo.tamuc.edu 

Learner Support 

The One Stop Shop was created to serve you by providing as many resources as possible in one 
location. http://www.tamuc.edu/admissions/onestopshop/ 

mailto:helpdesk@tamuc.edu
https://leo.tamuc.edu/
https://leo.tamuc.edu/
http://www.tamuc.edu/admissions/onestopshop/
http://www.tamuc.edu/admissions/onestopshop/
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The Academic Success Center provides academic resources to help you achieve academic 
success. http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/ 

COMMUNICATION AND S UP P ORT 
Interaction with Instructor Statement 

I generally respond to email questions within 24 hours 
 
Course Specific Procedures/Policies 
Missed examination: Missing Homework Assignment will result in zero score while missing the 
Final will result in grade “F”. There will be no make-up Exam or make-up Assignment. 
 
Syllabus Change Policy 
The syllabus is a guide.  Circumstances and events, such as student progress, may make it 
necessary for the instructor to modify the syllabus during the semester.  Any changes made to the 
syllabus will be announced in advance. 
 

 

Student Conduct 
All students enrolled at the University shall follow the tenets of common decency and acceptable 
behavior conducive to a positive learning environment.  The Code of Student Conduct is described in 
detail in the Student Guidebook. 

http://www.tamuc.edu/Admissions/oneStopShop/undergraduateAdmissions/studentGuidebook.aspx 

Students should also consult the Rules of Netiquette for more information regarding how to interact 
with students in an online forum: Netiquette http://www.albion.com/netiquette/corerules.html 

http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/
http://www.tamuc.edu/campusLife/campusServices/academicSuccessCenter/
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TAMUC Attendance 
For more information about the attendance policy please visit the Attendance webpage and Procedure 
13.99.99.R0.01. 

http://www.tamuc.edu/admissions/registrar/generalInformation/attendance.aspx 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/
academic/13.99.99.R0.01.pdf 

Academic Integrity 
Students at Texas A&M University-Commerce are expected to maintain high standards of integrity and 
honesty in all of their scholastic work.  For more details and the definition of academic dishonesty see 
the following procedures: 

Undergraduate Academic Dishonesty 13.99.99.R0.03 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/
undergraduates/13.99.99.R0.03UndergraduateAcademicDishonesty.pdf 

Graduate Student Academic Dishonesty 13.99.99.R0.10 

http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/13students/
graduate/13.99.99.R0.10GraduateStudentAcademicDishonesty.pdf 

ADA Statement 
Students with Disabilities 
The Americans with Disabilities Act (ADA) is a federal anti-discrimination statute that provides 
comprehensive civil rights protection for persons with disabilities. Among other things, this 
legislation requires that all students with disabilities be guaranteed a learning environment that 
provides for reasonable accommodation of their disabilities. If you have a disability requiring an 
accommodation, please contact: 

Office of Student Disability Resources and Services 
Texas A&M University-Commerce 

Gee Library- Room 162 

Phone (903) 886-5150 or (903) 886-5835 

Fax (903) 468-8148 

Email: studentdisabilityservices@tamuc.edu 

Website: Office of Student Disability Resources and Services 
http://www.tamuc.edu/campusLife/campusServices/studentDisabilityResourcesAndServices/ 

Nondiscrimination Notice 
Texas A&M University-Commerce will comply in the classroom, and in online courses, with all federal 
and state laws prohibiting discrimination and related retaliation on the basis of race, color, religion, sex, 
national origin, disability, age, genetic information or veteran status. Further, an environment free from 
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Topical Outline and Schedule of Assignments: The schedule will depend on class progress. Chapter assignments and 
tests may be altered as the class progresses. Students should read chapters and power point slides, and chapter Instructions 
provided by the Professor. 

Chapter  Modes of Instruction  Date/Due date   Chapter Goals  
Topic 1 
What is Statistics  

   

Lecture notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
      1. Understand why we study Statistics  

 2. Explain what is meant by descriptive 
statistics and inferential statistics  
3. Distinguish between qualitative and 
quantitative variables 
4. Describe how a discrete variable is different 
from a continuous variable 
5. Distinguish among the nominal, ordinal, 
interval, and ratio levels of measurement. 

Topic 2   
Describing Data: 
Tabular/Graphical 
Methods: 
Frequency tables, 
Frequency 
Distributions, and 
Graphic 
Presentations  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
     1. Organize qualitative data into a frequency 

table.  
2. Present a frequency table as a Bar Chart or a 
Pie Chart.  
3. Organize quantitative data into a frequency 
distribution. 
4. Present a frequency distribution for 
quantitative data using histograms, frequency 
polygons, and cumulative frequency polygons. 

Campus Concealed Carry Statement 
  

Texas Senate Bill - 11 (Government Code 411.2031, et al.) authorizes the carrying of a concealed 
handgun in Texas A&M University-Commerce buildings only by persons who have been issued and are in 
possession of a Texas License to Carry a Handgun. Qualified law enforcement officers or those who are 
otherwise authorized to carry a concealed handgun in the State of Texas are also permitted to do so. 
Pursuant to Penal Code (PC) 46.035 and A&M-Commerce Rule 34.06.02.R1, license holders may not 
carry a concealed handgun in restricted locations.  

For a list of locations, please refer to the Carrying Concealed Handguns On Campus  

document and/or consult your event organizer.   

Web url: 
http://www.tamuc.edu/aboutUs/policiesProceduresStandardsStatements/rulesProcedures/34SafetyOfE
mployeesAndStudents/34.06.02.R1.pdf  

Pursuant to PC 46.035, the open carrying of handguns is prohibited on all A&M-Commerce campuses. 
Report violations to the University Police Department at 903-886-5868 or 9-1-1. 
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Topic 3 
Describing Data: 
Numerical 
measures  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
     1. Calculate the arithmetic mean, weighted 

mean, median, mode, and geometric mean. 
2. Explain the characteristics uses, advantages, 
and disadvantages of each measure of location.  
3. Identify the position of the mean, median, 
and mode for both symmetric and skewed 
distributions.  
4. Compute and interpret the range, mean 
deviation, variance, and standard deviation.  
5. Understand the characteristics, uses, 
advantages, and disadvantages of each measure 
of dispersion. 
6. Understand Chebyshev’s theorem and the 
Empirical rule as they relate to a set of 
observations.  

Topic 4 
A Survey of 
Probability 
Concepts and 
basic rules 

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
     1. Define probability. 

2Describe the Classical, Empirical, and 
Subjective approaches to probability.  
3. Explain the terms experiment, event, 
outcome, permutations, and combinations 
4. Define the terms conditional probability and 
joint probability. 
5. Calculate probabilities using the Rules of 
Addition and the Rules of Multiplication.  

Assignment 1 Topics 1-4 Monday Sep 22  
Topic 5 
Discrete 
Probability 
Distributions  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

       1. Define probability distribution and 
random variable. 
2. Differentiate between discrete and 
continuous probability distributions.  
 3 Calculate the mean, variance, and 
standard deviation of a discrete 
distribution.  
4. Describe the characteristics and compute 
probabilities using the binomial probability 
distribution – use of tables and computer. 
5. Describe the characteristics and compute 
probabilities using the Poisson distribution 
– use of tables.   

Topic 6 
Continuous 
Probability 
Distributions  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
1. Understand the difference between discrete 
and continuous probability distributions. 
2. Understand the characteristics of the normal 
probability distribution. 
3. Define and calculate Z values. 
4. Determine the probability is between two 
points on a normal probability distribution. 
5. Determine the probability an observation is 
above or below a point on a normal probability 
distribution. 
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Assignment 2 
(Topics 5-6) 

Emailed and/or 
provided through 
D2L Brightspace 

by 11:59 pm 
Monday, Oct 13,  

Submit though D2L Brightspace 

Topic 7 
Sampling Methods 
and the Central 
Limit Theorem 

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
     1. Explain why a sample is often the only 

feasible way to learn something about 
population. 
2. Describe methods to select a sample. 
3. Define and construct a sampling distribution 
of the sample mean.  
4. Understand and explain the central limit 
theorem. 
5. Use the central limit theorem to find 
probabilities of selecting possible sample 
means from a specified population.  

Topic 8 
Estimation and 
Confidence 
Intervals  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
   1. Define a point estimate. 

2. Define level of confidence.  
3. Construct a confidence interval for a 
population mean when the population standard 
deviation is unknown: learn about t-
distribution. 
4. Construct a confidence interval for a 
population proportion. 
5. Calculate the required sample size for either 
an attribute or a variable. 

    
Topic 9  
One Sample Test 
of Hypothesis  

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

      1. Define Hypothesis and Hypothesis testing. 
2. Describe the five-step hypothesis-testing 
procedure.  
 3. Distinguish between a one-tailed and a two-
tailed test of hypothesis.  
 4. Conduct a hypothesis test regarding a 
population mean. 
5. Conduct a test of hypothesis about a 
population proportion. 
6. Define Type I and Type II errors. 

 

Assignment 3 Topics 7-9 Monday Nov10   
Topic 10 
Linear Regression 
and Correlation 

Chapter notes/PPT 
slides/Handouts 
through D2L 
Brightspace and 
emails 

 
     1. Understand and interpret the terms 

independent and dependent variables.  
2. Calculate and interpret coefficient of 
correlation, the coefficient of determination 
and the standard error of the estimate.  
3. Calculate the least squares regression line 
and interpret the slope and intercept values.  
4. Conduct tests of significance on the 
regression coefficients. 
 5. Learn about prediction of dependent 
variable using regression.  

  

Assignment 4 Uploaded in D2L 
Brightspace and/or 
emailed 

Monday, Dec 1 by 
11:59 pm 

Topic 10  
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 Final Exam: Time 
limit 7 hours once 
you start the test 
(single take and 
one stretch) 

Through D2L 
Brightspace 
Activities/Quiz/Exam 
section 

Window period: 8 
a.m. of Monday, 
Dec 8 till 11:59 
p.m. of 
Wednesday, Dec 
10. 

Chapters:  4-10 
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